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1 Software Requirements
This chapter describes the standard requirements for clients of users who access to the authoring station on MOSS2010. 

Operative System:

· Windows Vista

· Windows 7

· Windows 8
· Windows 10
Browser Internet:

· Internet Explorer 9.0 or later
MS Office:

In order to guarantee correct client integration between MS Office and MS Sharepoint 2013, it is advisable to use Microsoft Office 2013 or later versions.
2 System Authentication

· Intranet (Iveco employees)
· Once that user makes access to windows (through PC authentication), system automatically recognize the user who doesn’t need to login again (it will be possible when the single sign-in functionality will be available on the system. Today you need to log-in again with your username and password).
· VPN / Extranet (Iveco employees out of office, web agencies)
· User needs to login to the authoring station with his own username and password.

· Internet

· User doesn’t need to be inside the Iveco network to access to the system. If user has an Internet connection (it is advisable to use ADSL or highest connections) is able to access to the system from his own home or any other locations.
· How to access the system 
· Authentication must be done via secure internet access by typing the “https” address (e.g. https://auth.iveco.com/italy).
· User has to login typing his own present user name and password (as shown on the picture below).

Username: ivecoeurope\username
Password: your password

	From Intranet
	From Internet
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3 New User Creation

3.1 How to request a new user creation

For any request about a new user creation you have to fill a form and send it to GCSD (and in CC to your responsible) at the following e-mail address:
gcsd@iveco.com
You can find the document to send to GCSD into the EPortal at the following path:

EPortal => ICT Services => English Version => User Support => Legacy User Password

Once you sent the form document to GCSD you have to wait for a response from them:

GCSD will send to you the response by e-mail, containing your new user. 
3.2 How to ask for a grant change

For any request about grant change of user you have to follow the same process for a new user creation:

Send the request to GCSD by filling the form with all appropriate information and then wait for the response. 

3.3 Change / Reset password
The default password for the new user is set to Iveco2004 and you have to change it at the first access. 

You can do that by:

· Connecting via VPN (of yours or any of your colleague) to  https://pwchangead.iveco.com/index.php and follow the instruction on that web page.

· Who doesn’t have a VPN connection can access via internet to https://vpnssl.iveco.com and change the password following the web page instructions.
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· Sending an email to ccc-useradmin@globalvalue.it (this one has to be sent by an iveco e-mail account putting in copy the pertaining responsible). In this email you have to write:

· First name: 

· Surname: 

· Userid:

· Company:

· Involved Domain, mainframe, system or application:

· Email address: 

3.3.1 Password requirements
The password expires every three months. To change the password a user has to remember that cannot choose the same previous one and must follow some security requirements.
For setting a new password properly user must remember to insert:

At least 8 characters with:
· At least 1 capital letter

· At least 1 number and/or at least 1 special character (!, £, $, %, &, etc.)

To change your password you have to:

· Type your username

· Type your old password

· Type your new password (with policy requirements)

· Retype the new password (verify).
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After that, if the system is not able to change it could mean that:

· You typed a wrong username.

· You typed a wrong old password.

· You typed a wrong new password (without requirements).

· You typed the same password for the old and the new password.

· The New password doesn’t match with the New password verify.

If you don’t remember your old password you are not able to change it by yourself, so you need to ask for a reset (to do that see the previous paragraph).

3.3.2 Password locked

When a user type a wrong password for five consecutive times his own account locks itself and user needs to wait for at least 1 hour before he can use it again (because after 1 hour the account unlocks itself automatically). If a user doesn’t remember his own password anymore and keep on typing the wrong one, he needs to ask for a reset. 

4 Help / Request references

Following you can find the reference contacts for what concerning support about the web sites managing. 

Those contacts follow the standard processes of Iveco.
Customer Service Center:
To inform ICT about problems, errors or service unavailabilities while using the web platform:

Call the CSC (Customer Service Center)

When you call please choose this option: dial #2, than #2

ICT Support:

For technical support you can write to: 

ictweb@iveco.com
Business Support:

To ask and verify with the central marketing web dept. content availability and communication request/problems you can write to:

 web@iveco.com
5 Authoring Web Site Navigation and Structure
SharePoint has a WYSIWYG approach. It is an acronym for What You See Is What You Get used to describe a system in which content during editing appears very similar to the final product. 
It implies a user interface allows the user to view something very similar to the end result while the document or image is being created or edited.

We have two main ways to navigate, view or edit the contents of the site. You can do it by selecting View All Site Content from the Site Actions menu. 
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The View All Site Content you can see only the structure of the section that you are using now. For example if you are navigating the site and you are located on the product section, when you select View All Site Content you are going to see only the structure of it and not the entire structure of the site. It is useful because it is immediately and quickly.
5.1 Document Libraries

As said before, the site is organized in folders and items as an explorer of your operative system. 

When you use the All Site Content navigation you are able to see the structure of your website organized by folders called Document Libraries and you can move through them creating folders and uploading files inside.

Each section of the site (Products, Services, Press room, etc.) contains by default 3 different document Libraries:

Documents: folder where you can upload various documents files (as doc, pdf, flash, etc.) inside.
Images: library where you can upload any images you need.

Pages: library where are located all pages created (concerning the web site area where you are located now e.g. Press Release).
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Each of those Libraries can contain inside any other folders, so you are free to organize yourself as you better prefer. You can load a doc file inside the Documents libraries or you can also decide to create a folder (naming it as you want) and loading your file into it.

5.2 Manage Document Libraries
Let’s see how to create a folder and upload a file inside.
Supposing that you need to upload a file on the system to use, do the following:
Select View All Site Content from the Site Actions menu
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From here we can access to our Documents Libraries.

Note the path of the section. By the View All Site Content you are able to see always your current location inside the system (see the path below).
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Enter now into Documents. 
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Now you can upload a file here from your PC or you can create a folder before doing that because you need to organize your job in a more structured way.

Under Files Tools => New Folder
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Choose the name for your folder and then press Save
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Now you can see your folder just created. Enter inside it and upload a file.
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Press Upload and select Upload Document
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Select Browse…
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Now you can see the explorer window of your PC. Search for your file, select it and then press Open.
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Press OK
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Under the tab Edit press Check-In
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Your file has been uploaded properly
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5.3 Ribbon 

The Ribbon is a toolbar that appears across the top of each page and displays many of the most commonly-used tools, controls and commands. The number and types of controls that appear on the ribbon vary according to context and depend in part on the type of page you are viewing, the level of control that your administrator has granted to users, and your permission level within the site. Tabs, groups, and commands on the ribbon are contextual. Therefore, the ribbon commands available to you change depending on where you are and what you are doing. For example, the Navigate Up command is only available when you navigate into a folder in a list or library
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In SharePoint 2013 in the ribbon instead of Site Actions there is a Wheel[image: image20.png]
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Page Ribbon

· Browse: Returns you to the Breadcrumb Trail
· Page: Check out/check in the page, manage page permissions, library settings and library permissions.
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· Editing Tools -> Format Text : Check out/check in the page, customize page
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· Editing Tools -> Insert : Add tables, images, links, upload files, add web parts, and create new lists.
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Library Ribbon
The ribbon that appears when you select a library from the Libraries list differs from the site page ribbon illustrated in the previous section.

· Browse: Returns you to the Breadcrumb Trail
· Library Tools -> Files: Create a new document, upload documents, manage document permissions. Use this tab to work on individual documents.
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· Library Tools -> Library: Modify the view, create a new view, manage library setting and permissions. Use this tab to work on the library as a whole.
[image: image26.png]SharePoint B 2
srowse | s | UsraRy G swave vy rouow Fswe I

ModityView . Cuent View: Export to bcel = o
=== © a8 Bk 4 BRE mS &
[ Create Column | All Documents  ~ N 7" Open with Explorer A
Vew Quck | Create Tws&  Emale et RSS  Comedio Comectto FomWeb  ESt NewQuide  Lbrary Shared Workiow
B VO NavosteUp | o cumentpage » | e TR MeT ree “BlGok” “Brce Fas Ubey | S seings Wih setingse

View Format Manage Views “Tags and Notes Share & Track ‘Connect & Export Customize Lirary settings





6 Content Management 
In this chapter, it is shown how to manage contents as author on the system. In the next paragraphs we are going to see how to create/edit a page and manage contents (text, images, attachment, etc.) using the main controls of the site
6.1 Content Attributes
This chapter includes all the useful information about the main page setting functionalities.

From the Page Setting menu, you will able to:
· Save a page

· Check in a page

· Discard Check out of a page

· Delete a Page

6.1.1 Save Page

There are some options for saving a page, most of which can be accessed on the “Page Editing” ribbon. To use the Ribbon, click the tab Page, and then click Edit.
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For saving the page and continuing to edit it on the “Page Editing” ribbon, click the tab Page, and then the dropdown menu of Save, then click Save and Keep Editing. To save the page and see it in the rendered view (as a preview) on the Page Editing toolbar, click the tab Page and then click Save.
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6.1.2 Check-Out of a Page

When you click “Edit Page”, the page is automatically checked out on the Pages Library, which prevents other people from editing it. The check-in and check-out system helps prevent multiple versions of the same page from being created at the same time. The system manages this by allowing only the checked-out version of a page to be edited.
When you check out a file from a library you ensure that others cannot make changes to the file while you edit it. While the file is checked out, you can edit it and save the file, close it, and reopen it. Other users cannot change the file or see your changes until you check in the file. Checking out a file prevents multiple people from making changes at the same time, which helps to avoid conflicts and confusion over changes. When a file is checked out, no one can edit it except the person who checked it out.

6.1.3 Check-In of a Page

To collaborate on the same Web page, an author must check the document in before another author can check it out to contribute changes. 

To check in the page and allow other users to access it, do the following:

On the page that you are editing from the ribbon go to Page tab, click Check In.

When you check in a file, you release the lock for editing and enable other users to view the updated file or check out the file. 

When you check in a file, you can type comments about the changes that you made to the file. This helps people understand what changes you made to the file since you had it checked out. Check-in comments are especially helpful if several people work on a file. 

Typically, you should check in only the files that you checked out. You will receive a warning if you check in a file that is checked out to someone else. If you check in the file, you overwrite any changes that the other person made to the file.
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6.1.4 Discard Check Out of a Page

You can use this option to come back to the original version of the page. For example: while you edit contents on a page you discover that you made some mistakes, by clicking on Discard Check Out the page will come back to the last status of the page (before your last changes). 

Select “Discard Check Out” from “Page” tab => “Check In” menu.

You’re going to receive an alert message: any data that has not been checked in will be lost.

6.1.5 Delete Page and Recycle Bin

There are several ways to delete a page:

· From the page itself, in editing click on the Page tab and then press delete Page. 

· From the Pages Library, choose the page and select Delete.

 [image: image30.png]Messaggio dalla pagina Web

Are you sure you want to et without saving? Any unsaved data will be:
lost,





Once you deleted an item, it is not completely lost. 

You can view the item just deleted into the Recycle Bin. (Site Actions => View All Site Content => at the bottom Recycle Bin).
You can also decide to restore an item from the Recycle Bin just flagging the check box of your interested file and then clicking the “Restore Selection” button.

Items that were deleted more than 30 days ago will automatically erased.
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Use this page to restore items that you have deleted from this site or to empty deleted items. Items that were deleted more than 30 day(s) ago will be automatically emptied. To manage deleted items for the entire Site Collection go to the Site Collection Recycle Bin. 
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6.1.6 Version History of a Page

You can view the version history for a page, from the Pages Library that contains the page that you want the histor. Click on the right of file, open the dropdown menu and then click “Version History”. 
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The Major version is a numbered copy of a file that has changed significantly since the previous major version. Each major version is identified by a whole number (1, 2, 3 ...) to indicate that it is published for a wider group in your organization to view.

The minor version is a decimal-numbered copy (0.1, 0.2, 1.1 ...) of a file that is in a stage of revision or that has changed only slightly since the previous version. Typically, a minor version is not published for a wider group in your organization to view.
6.1.7 View Version Details

You can use versioning to “View a previous version”.  

You can view a previous version without overwriting your current version.
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6.1.8 Unpublish a Version
You can also “Unpublish a version”. For this operation you can use the drop down list or the button in the ribbon.  
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6.1.9 How to publish a file
Supposing that we have created a page into the Pages Document Library of a section of our website, let’s see how to publish it now.

By View All Site Content, enter into Pages
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Here are located the page.

As you can see below the Approval Status of the file is Draft, which means that the file is visible by you as author, but not yet by an Internet user. 

Proceed now to publish the item selecting its arrow and pressing Publish a Major Version.
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It is also possible to use the Ribbon to Publish a file.
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To publish a file the system always requires that file is checked-in. You can insert an optional comment about it and then press OK.
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You can see now that the Approval Status of the file is changed from draft to pending, which means that file has still to be approved by a reviewer or by yourself (if you are also an approver) .
It is possible to perform an approve using the arrow under the file or using the ribbon.
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Flag the Approved box and press OK
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Press Ok if you receive any alert messages.

As you can see below the file has been approved properly and the status is changed from Pending to Approved.
6.2 Create a new general Page

Enter into the web area of your interest and select View All Site Content from the Site Action menu then enter into the Pages library
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press New => Page
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In this case, the page will be located at the following path:

Your site => Sala-stampa => Comunicato  => Pages

Once you selected New Page the next step is to choose the title and the layout to use for the page.
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Into the Title box, type the name for the page. 

The Description box is an optional field where you can type description about the contents of the page. 

The URL Name box is the web address of the page and it is automatically filled with the text of title box. You can accept the default title (which is the same as the “Title”) or you can type a new URL Name for the page.

You have to set just the name of the page that will complete the web address automatically. Do not enter the entire server relative URL.

The suggestion is to choose a short name for it.
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Into the “Page Layout” field, select a layout for the page that you want to create. 

Depending on the type of layout you choose (see the Layout chapter for more information), you may have a combination of field controls and Web Parts on the page. You can add content to the page by editing and configuring each of these elements individually. The page designer determines which elements appear on the page. Field controls cannot be moved around on the page and are used to maintain consistency among pages and sites.
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Then click Create.
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Once you selected the layout you need, you will get a blank page where the only box already filled is the Title field (text field that you set before) and you can change it, as you want. 
The rest of the page is completely blank with empty boxes that you can use to fill the page with different type of contents (you can view the entire page by the scrollbar on your right).

In the next paragraphs, you will find how to use them.
6.3 Html content
The following field can be edited using the most common functionalities of Microsoft Word Office.
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When you click on Click here to add new content you are going to see the ribbon, and under Editing Tools, there are two tabs:

· Format Text 

· Insert

 The first one allows users to define alignments, format, colors, etc. Do not use the font’s field. Use always the default one.
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The Insert tab is intended to insert tables, images, hyperlinks and so on, just as you usually do working with MS Word. 
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6.3.1 Hyperlinks 
If you need to create a link to a specific page, select the part of text that has to be clickable and then press the “Link” button. 
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Then you can decide where to pick the address of the link, from Sharepoint or from a specific Address.
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Type the web address to open into the “Location (URL) or “Address” field and press OK. After that, a new tab (Link Tools) will appear above the ribbon.

Using this you can also define if opening the link on a new window or not.
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To save the page click the tab Page and press the save icon.
6.3.2 Images 
If you want to insert an image on a Content Html field, click on the “Picture” button. 
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As for the Link, also here, is possible to choose if the picture has to be taken from Sharepoint or from an address. In the case of the Picture it is also possible to specify an image directly from the Computer.
The picture will be also uploaded in the Sharepoint site. 
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By browsing the window, you will access to your system resources to find the image located in your computer and upload it into the Images library on SharePoint. 

Select the image from your PC and then press open. It is also necessary to specify the position of the image on the site using the drop down list of “Upload to”. After that, you can press the Ok button and the window of uploading file (already seen) will appear.
Here you can use the check in button or scrolling down the window up to the save button just to save the image without checking in.
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After that, a new tab will appear over the ribbon (Picture Tools > Design).

The Change Picture allows you (using the arrow menu) to change the picture and take it From Computer, From Address or From SharePoint, seen before. It is also possible to specify an alternative text of the image.
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Furthermore, you can edit the size of the image keeping the Aspect ratio, acting directly on the image or setting the size using horizontal Size and Vertical Size.
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In this case, you have uploaded an Image directly from your PC, but it has not been published yet, so remember to go on your Images library and follow the approval processes. If you don’t do that, the image will not be visible by the internet users.
6.4 Link Picker

There is also another field that you can find inside pages or lists: the link picker control. 
With this control, you can specify a link or a picture by pressing the browse button and choose the file you need. 
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Pay attention: take care to specify always site relative path. For example:

· Wrong path: https://auth.iveco.com/italy/PublishingImages/canvas-hp/01.jpg 
· Correct path: /italy/PublishingImages/canvas-hp/01.jpg
6.5 Common Resources

There is a particular sub-site called common where are stored all the resources that are common to all markets. Here you can find, for example, the icons and the images that are shared in all markets.
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This section is available to editors in read mode only. Write mode is reserved to site collection administrators.
7 Massive Upload – Drag and drop
In SharePoint 2013 on any document library, you can now simply Drag and Drop the document and it will be upload with a quick progress bar. Here is how this feature works:

· simply select multiple document from local and drag it onto the document library. The window will change to “Drop here…”
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· You can see the Upload documents Status bar next at the Document Libraries title
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· You would see Upload Complete once the upload completes.
8 Page Layouts
This chapter describes the main Page Layouts of the web site.

Depending on the type of layout you choose, you may have a combination of field controls and Web Parts on the page. You can add content to the page by editing and configuring each of these elements individually. The page designer determines which elements appear on the page. Field controls cannot be moved around on the page and are used to maintain consistency among pages and sites.

Every time you create a page you must select a page layout from a list (see the image below). 
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The next paragraphs of this chapter will show you the main Page Layouts and their own functionalities.
8.1 Home Page
This page has two main zones: the configurable slider and the body that contains some internal widgets. 

Desktop view:
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Mobile view:

[image: image67.png]IVECO =

IVECO TRIONFA
ALLA DAKAR 2016
. e }





You can edit this page from the Site Actions menu, selecting Edit Page or using the edit functionality available from the Ribbon.
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In editing mode, you can set the following fields:
1) The Browser Title represents the name displayed in the upper side of the internet browser. It is used for the SEO;
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2)  Slider: you can select the folder containing images and videos to display in the slider. For further information please refer to next paragraphs;

3) Widgets: you can add and configure widgets inside available web part zones. For further information please refer to next paragraphs;
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8.1.1 Slider Management
The sliders are configured by means of a dedicated list named SliderCollections available at the root level of market site.
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Each folder inside the list represents a collection of slider. 
You can configure a variable number of image items or a single YouTube video. If you want to create your own collection, use the new folder button specifying a unique name.
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Now you can access the folder and add Image Items (ImgElement) or a single youtube Video Item (YouTubeElement).
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If you use ImgElement you have to specify the name of the image, the UrlTarget and UrlLink that are referred to a hyperlink connected to the image, the position of the item in the collection and the specific URL of the image. Be sure that the specific URL of the image is set as relative path and do not insert entire server relative path:
· wrong path:
https://auth.iveco.com//italy/PublishingImages/canvas-hp/canvasHP.jpg

· correct path:
/italy/PublishingImages/canvas-hp/canvasHP.jpg
Optionally, you can set a overlapped box over to see over the image setting the fields SliderTitle and  SliderSubtitle. By using the SliderTextPosition you can set the bosition of the box over the image (Top Left, Top Right, Bottom Left and Bottom Right).
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If you want to include a YouTube video, use a YouTUbeElement. Then insert the title of the item, the position and the YouTube embed URL inside the video1Src field. 
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Below, a link example that can be copied directly from YouTube page:
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Pay attention: in this release, a collection can contain only one YouTube video.

8.1.2 Widgets Management

8.1.2.1 How to add a widget
To add a widget in a section, do the following steps:

1. Click Add a Web Part on the target WebPartZone.
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2. Under the Custom category, select the widget you need
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Press the Add button.
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8.1.2.2 How to configure a widget
Once you have added your interested widget, you can edit it selecting Edit Web Part, as shown below. 
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As an alternative, you can also use the Web Part Tools Tab and select Web Part Properties from Ribbon.
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The web part will be displayed in Edit Mode and a toolpart will appear on the top side:
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For further Information about widgets see the Web Widgets Chapter.

8.2 Main Page

This is the main template of the site. 
The Main page is the layout typically used for the creation of new pages like those of the products typology and it is structured as follows:

1. Top Image (assigned to the page through the Navigation feature)

2. Breadcrumb

3. Left navigation menu (configurable through the Navigation feature)

4. More Information feature (configurable through the Navigation feature)

5. Page content (marked in red below). It is possible to edit the contents directly in page by using the appropriated field controls.
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8.2.1 Create a new page
To create a new page by using the main page layout you need to follow the next steps: 

· Go first to the interested sub site
· Using the Ribbon, select from the File tab, New Document > Main Page.
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The next step is to select the type of page and its URL name
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For the creation of the new page it is necessary to specify the following fields:

· Title: the Title of the page.

· Description: it is possible to specify a description about the content of the page. This is an optional field.

· URL Name: it is possible to specify a specific url address to assign to the page. Typically this field is automatically compiled by the system with the Title one previously assigned to the page. If the name contains multiple words it is suggested using a dash or underscore between the words as the following example:

· Correct: new-vehicle or new_vehicle

· Wrong: newvehicle

· Wrong: new vehicle

· Page Layout: you need to select here the (Iveco Page) Main Page layout, which means the correct template to associate to the new page. 

Once all previous fields are properly configured it is possible to select the Create button in order to create the new page.
Now the page just created is in Draft status which means that it is visible only to yourself and the other editors of the site.
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8.2.2 Edit the content of the page
To edit the new page do the following:

1. Select Edit Page from the Site Actions menu or select Edit Page directly from the page editing toolbar.
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Once the page is switched in editing mode there are some features that are configurable:
1. The Browser Title represents the name displayed in the upper side of the internet browser.
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2. Title canvas, description canvas, position:
Display View:
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Edit View: 
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Here you can insert a Title, a Description and select the position of the text over the canvas image

3. Image, youtube video or flickr gallery zone: 

Display view:
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Edit view:
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Here you can insert a photo, a youtube video or a Flickr gallery. You have to fill just one of the three choices:
· If you want to display an image, fill the Image Box. For further information, see the Images Chapter. Be sure to insert the relative path to Sharepoint location where is the image)
· wrong path:
https://auth.iveco.com/italy/PublishingImages/image.jpg
· right path:
/italy/PublishingImages/image.jpg


· If you want to display a flickr gallery, fill the Flickr Box specifying the Flickr user
· If you want to display a youtube video, fille the YouTube Box specifying the url of a YouTube video.

Below, a link example that can be copied directly from youtube page:
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4. The Page Sub Title is the sub title displayed below the main title of the page
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5. In the read more configuration you can insert text that are displayed when users click the “read mode” button of the page
Display view:
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Edit view:
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6. The Tools and Technical Sheets area are configured accessing the Navigation page. For further details, see the related chapter.
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Optionally, you can change the label of catalogs (see: “Cataloghi” label in tools section image) and the label of technical sheets (see: “SCHEDE TECNICHE” label in tech sheets section image) for the current page instance using the “Optional new Catalogs and Technical Sheets labels” section as below:
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7. You can also add widgets through the available web part zones on the bottom of the page. For more information, please refer to the Widget Management chapter.
8.3 Promotion Page

The Promotions feature allows content editors to publish promotional pages into the site.
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A promotional page provides standard SharePoint content (top image, titles and body text) plus a small right

placed form that users can use to supply contact information.

Contact information is packed and sent to the Customer Service and is used to contact users interested in

Promotions.
8.3.1 How to create and manage a Promotion page

Steps to create and publish a new promotion page will be depicted in the following.

· Access to the “Promotions” section of the reference market (i.e. “Italy”) and create a new “Page”. (in the ribbon, File tab > New Document > Iveco Promotion Page);
· Fill in the title of the new page and choose the page type “(Iveco Promotion Page) Promotion Page”
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· Select the page just created and choose “Edit Page” on the top editing toolbar
You can manage the following sections:
8. Home Page Promotions Slider Info. In this zone you can set the slider of the Homepage of promotions:

1) The checkbox indicates whether the information have to be rendered in the slider of the homepage or not;
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9. Additional Promotion Info: You can use the “Show more Info Box” checkbox in order to show or to hide in view mode the small right placed contact form of the promotion page. Furthermore, in this zone you can set the information of the lead related to the promotion sources of the current promotion page:

· Used / New Range;

· Promotion Source;

· Initiative Report Source;

· Initiative Report Detail.

There are also some optional fields that are used if you want that the leads generated from this promotion will be forwarded to someone different than the default one
· To;
· Cc;
· Send mode.
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10. Main Zone. In this area you can set:
· the browser title;
1) the page title (Promotion Title field);
2) the image of the promotion (Header Image field);

3) the title related to the canvas image;
4) the description related to the canvas image;

5) the text position related to the canvas image;

6) the category for the current promotion (Promotion category combo);
7) the main content of the promotion (Main content field);
8) the mobile  main content of the promotion (Main content Mobile field);
9) the read more content (Page Additional Content field inside Read more configuration zone);
10) the read more content (Page Additional Mobile Content field inside Read more mobile configuration zone);
11) up to three widgets (Bottom WebParts zone);
Desktop view:
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Mobile View:
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8.4 Ghost Page

The Ghost Page feature allows content editors to publish ghost pages into the site.
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A ghost page does not require to be added in the navigation of the market site (stand alone pages).
It provides standard SharePoint content (top image, titles and body text) and a small right placed form that users can use to supply contact information.

Contact information is packed and sent to the Customer Service and is used to contact users interested in

ghost page content.
8.4.1 How to create and manage a Ghost page

Steps to create and publish a new ghost page will be depicted in the following.

· Access to the “Pages” section of the reference market (i.e. “Italy”) and create a new “Page”. (in the ribbon, Library Tools tab > Documents > New Document);

· Fill in the title of the new page and choose the page type “(Ghost Page) Ghost Page”
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· Select the just created page and choose “Edit Page” on the top editing toolbar.
You can manage the following sections:

11. Additional Ghost Page Info: You can use the “Show more Info Box” checkbox in order to show or to hide in view mode the small right placed contact form of the ghost page. Furthermore, in this zone you can set the information of the lead related to the promotion sources of the current ghost page:

· Used / New Range;

· Promotion Source;

· Initiative Report Source;

· Initiative Report Detail.

There are also some optional fields that are used if you want that the leads generated from this promotion will be forwarded to someone different than the default one

· To;
· Cc;

· Send mode.
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12. Main Zone. In this area you can set:

· the browser window title;
1) the page title (Ghost Page Title field);
2) the image of the ghost page (Header Image field) or the video of the ghost page (Youtube Video Link field);
3) the youtube URL

4) the title related to the canvas image;

5) the description related to the canvas image;

6) the text position related the canvas image;
7) the main content of the ghost page (Main Content field);
8) the main content mobile of the ghost page (Main Content Mobile field);
9) the read more content (Page Additional Content field inside Read more configuration zone);
10) the read more content mobile (Page Additional Content Mobile field inside Read more configuration zone);
11) up to three widgets (Bottom WebParts zone).
Image mode:
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Desktop view:
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Mobile view:
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Video mode:
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Desktop view:
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Mobile view:

8.5 Empty Page

T.B.D.
8.6 Mini Configurator Page

The Mini Configurator Page is the layout typically used for the creation of new pages like those of the products typology:
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8.6.1 Create a new page
To create a new page by using the mini configurator page layout you need to follow the next steps: 

· Go first to the interested sub site

· Using the Ribbon, select from the Files tab, New Document > New Document.
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The next step is to select the type of page and its URL name
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For the creation of the new page, it is necessary to specify the following fields:

· Title: the Title of the page.

· Description: it is possible to specify a description about the content of the page. This is an optional field.

· URL Name: it is possible to specify a specific URL address to assign to the page. Typically this field is automatically compiled by the system with the Title one previously assigned to the page. If the name contains multiple words it is suggested using a dash or underscore between the words as the following example:

· Correct: mini-configurator or mini_configurator

· Wrong: miniconfigurator

· Wrong: mini configurator

· Page Layout: you need to select here the (Iveco Page) Iveco Mini Configurator Page layout, which means the correct template to associate to the new page. 

Once all previous fields are properly configured it is possible to select the Create button in order to create the new page.

Now the page just created is in Draft status which means that it is visible only to yourself and the other editors of the site.

8.6.2 Edit the content of the page
To edit the new page do the following:

1. Select Edit Page from the Site Actions menu or select Edit Page directly from the page editing toolbar.
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Once the page is switched in editing mode there are some features that are configurable:

1. The Browser Title represents the name displayed in the upper side of the internet browser.
2. The Page Title is the title displayed below the top image
3. If display or not the More Info Box
4. The Page Sub Title is the sub title displayed below the title of the page
5. The Main Content is the 
6. The Tools and Technical Sheets area are configured accessing the Navigation page. For further details, see the related chapter. 
7. The label of catalogs (see: “Cataloghi” label in tools section image ) and the label of technical sheets (see: “SCHEDE TECNICHE” label in tech sheets section image  ) for the current page instance using the “Optional new Catalogs and Technical Sheets labels” section.
You can also add widgets through the available web part zones on the bottom of the page. For more information, please refer to the Widget Management chapter.
8.6.2.1 Mini Configurator Form

The Configurator Form is configured by the file data.js of a dedicated Document Library named MiniConfigurators available at the root level of market site.
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To create a new configuration select a value in the dropdownlist and then click on calculate. In the bottom of the form we can display the result of the configuration.
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8.7 Iveco After Sales - Additional Layouts
The After Sales sub site allows editors to use two additional layouts:

· Section Home Page

· Internal Section Page

8.7.1 Section Home Page

This is the home page for the after sales sub site. 
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8.7.1.1 How to create and manage a Section home page

To create a new page by using the Iveco Section Home Page layout you need to follow the next steps: 

· Access to the Pages list inside the After Sales sub site of the reference market (i.e. “Italy”) and create a new “Page”. (in the ribbon, Files tab > New Document > Iveco Page);
· Fill in the title and the URL of the new page. Choose the page type “(Iveco Page) Section Home Page”
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· Select the page just created and choose “Edit Page” on the top editing toolbar
Edit View:
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The section homepage has nothing different from the layout seen before, you can:

1) Specify a collection for the slider. Please see the Slider Management paragraph for more information;
2) the browser window title;
3) the page title (Ghost Page Title field);
4) Configure widgets inside the available web part zones (WebPartZone_1st_Row, WebPartZone_2nd_Row, WebPartZone_3rd_Row). In order to add widgets please refer to the Widget Management chapter. 
Pay Attention: every web part zone cannot contains up to three widgets.
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8.7.2 Internal Section Page

This is the template for the After Sales internal pages. 
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8.7.2.1 How to create and manage an Internal Section Page

In order to create a new page by using the Iveco Section Page layout you need to follow the next steps: 

8. Access the Pages list inside the After Sales sub site of the reference market (i.e. “Italy”) and create a new “Page”. (in the ribbon, Files tab > New Document > Iveco Page);
· Fill in the title and the URL of the new page. Choose the page type “(Iveco Page) Section Page”
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· Select the page just created and choose “Edit Page” on the top editing toolbar
Edit View:
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In this layout you can:
1. Set the browser title;

2. Set the page title (PageTitleHtml field);
3. Set the main content of the page (Main Content field). You can add normal text or text formatted as title using the Edit Source in the Ribbon;
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4. Set the main content mobile of the page (Main Content Mobile field);

5. Set the read more content (Page Additional Content field);
6. Set the read more mobile content (Page Additional Mobile Content field).
8.8 Iveco Dealer Landing Page
T.B.D.
9 Web widgets

The web widgets are custom web part built in SharePoint 2013 that allow implementing various features useful for the site. 

To add a widget in a page you have to access it in Edit mode and then it is possible to add widgets in web part zones. In order to add a widget click Add a Web Part and you will be able to add several web parts on the page by choosing them from the Gallery, which is organized by categories. 
Select the interested web part and click the Add button to add it.
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Accessing the widget in edit mode you can set the values for it by means of a form called toolpart. 

[image: image129.png]Newsletter Web part... ¥

Minimize

[/ e

X Delete

E edit web part

Tieniti semprg  Export.. e
novita del mondo Iveco




                   [image: image130.png]Select Newsletter:
newsletter v





These are the customized web widgets available for Iveco.com:

· Iveco Box

· Iveco Large Box

· Iveco Configurators Box

· Iveco Dealer Locator Box
· Iveco Newsletter Box

· Iveco Promotions Box

· Iveco Tag Cloud Box

· Iveco Mail Alert Box

· Iveco News Box

· WPImageLinks

Create items inside WebPartsList list available at the root level of every market to configure the widgets. 
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9.1 How to create new item for widgets
Accessing the WebPartList list and then, by means of the ribbon, follow List Tools -> Items -> New Item. Now you can select the kind of items you need.
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Following a more detailed description for each widget.

9.2 Iveco Box

This widget is used to create single, double or triple column box, with sliding effects or not.
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If you want to create new Iveco Box, you have first to add new “IvecoBox” items within the WebPartsList list, as shown below.
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You have to configure the following fields:

1. Title: the title of the text paragraph
2. SubTitle: the sub title of the text paragraph

3. Abstract: an abstract for the widget

4. ImageUrl: the url of the image shown in the box

5. PageUrl: the url of the linked resource

6. Target: how to open the linked resource (same page, new page)

7. Alternative Text: text shown in alternative to the image

In order to link resources located in SharePoint (i.e. values for ImageUrl or PageUrl) be sure to enter the relative path to the location where the file resides in and do not enter the full server path:


· wrong path:
https://auth.iveco.com/italy/PublishingImages/file.jpg

· right path:
/italy/PublishingImages/file.jpg

Create all IvecoBox items you need.

Now you can add a new Iveco Box widget inside a page. 

To use this widgets, access the page in Edit mode and, within a WebPartZone, follow  Add new Web Part -> Custom -> Iveco Box.

[image: image140.png]Categories Parts
&1 Apps [iveco Box
[ Blog [Diveco Configurators Box
3 Content Rollup [Eliveco Dealer Locator Box
e Lo 5
g Default [Eliveco Mail Alert Box
3 Document Sets [Eiveco More Info
= Forme

<

3

Upload a Web Part +

[Eiveco News Box

[Eliveco Newsletter Box
[Hiveco Promotions Box
[Hliveco Tag Cloud Box
[EWPImagesLink




Press the Add button to confirm.
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In edit mode of the widget you can set the configurations for it by means of the toolpart. You can specify the following properties: 

1. Category: the text inside the black label

2. Icon Url: the url to the image to shown as icon of the black label

3. Slide Box: if checked the widgets use a slide effect

4. Box 1, Box 2, Box 3: inside these boxes you can select the items previously insert inside the WebPartList list. Here you can only view “IvecoBox” items.
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Press OK button to confirm your configurations.

9.3 Iveco Large Box

This widget is used to create two columns box, containing a single image and, even if not mandatory, a title, a description and a link to an external or internal page. 
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The widget can also display a single image without title or description. The image must have properly size in order to completely fit the box.
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If you want to create new Iveco Large Box, you have first to add new “IvecoBoxLarge” items within the WebPartsList list, as shown below.
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You have to configure the following fields:

1. Title: the title of the text paragraph;
2. SubTitle: the sub title of the text paragraph;
3. Abstract: an abstract for the widget;
4. Alternative Text: text shown in alternative to the image;
5. ImageUrl: the url of the image shown in the box;
6. PageUrl: the url of the linked resource;
7. Target: how to open the linked resource (same page, new page);
In order to link resources located in Sharepoint (i. e. values for ImageUrl or PageUrl) be sure to enter the relative path to the location where the file resides and do not enter the full server path:


· wrong path:
https://auth.iveco.com/italy/PublishingImages/file.jpg

· right path:
/italy/PublishingImages/file.jpg

To create a new Iveco Large Box widget, access the target page in edit mode and, in a WebPartZone, click the Add new Web Part button, then follow  Custom > Iveco Large Box.
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Press the Add button to confirm.
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In edit mode of the widget you can set the configurations for it by means of the toolpart. 
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You have to specify the following propertes: 

· Category: text inside the black label

· Icon Url: the url to the icon
· Box: here you can select the item previously insert inside the WebPartList list. Here you can only view “IvecoBoxLarge” items. 
Press OK button to confirm your configurations.

9.4 Iveco Configurators Box

This widget is used to create box with direct links to the prompt delivery configurator of the site. 
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If you want to create new Iveco Large Box, you have first to add new “IvecoBoxLarge” items within the WebPartsList list, as shown below.
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You have to configure the following fields:

1. Title: the title for the widget;
2. CategoryLabel: The text of the label shown in the top of the widget;
3. IconUrl: the url of the icon shown in the top of the widget;
4. ImageUrl: the url of the image shown inside the widget;
5. Alternative Text: the alternative text for the image;
6. Abstract: the abstract of the widget;
7. SelectLabel: the label for the drop down list (see picture above);

8. Target: how to open the linked resource (same page, new page);
9. ToolName: Select one of the available IvecoConfigurators(Configurator, StockAvailability, Mission);
In order to link resources located in SharePoint (i.e. values for ImageUrl or PageUrl) be sure to enter the relative path to the location where the file resides and do not enter the full server path:


· wrong path:
https://auth.iveco.com/italy/PublishingImages/file.jpg

· right path:
/italy/PublishingImages/file.jpg

To create a new Iveco Configurators Box widget, access the target page in edit mode and, in a WebPartZone, click the Add new Web Part button, then follow  Custom > Iveco Configurators Box.
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Press the Add button to confirm.
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In edit mode of the widget you can set the configurations for it by means of the toolpart. 
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Here you can only select one of the available IvecoConfigurators previously added in the WebPartsList list. 

Press OK button to confirm your configurations.

9.5 Iveco Dealer Locator Box

This widget is used to create boxes that allow the user to find Iveco’s concessionaires and workshops.

It is possible to choose a brand between Iveco and Irisbus and an address. 
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Pressing the search button the widget open the dealer locator page with the brand and the address chosen by the user.

If you want to create new Iveco Dealer Locator Box, you have first to add new “IvecoDealerLocator” items within the WebPartsList list, as shown below.
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You have to configure the following fields:

1. Title: the title of the widget
2. CategoryLabel: The text of the label shown in the top of the widget
3. IconUrl: the url of icon shown in the top of the widget
4. ImageUrl: the url of the image shown inside the widget
5. Alternative Text: the alternative text for the image
6. Address label: the label in the text box of the address (not available)
7. Button Label: the label of the button to start the search
8. Target: how to open the linked resource (same page, new page);
In order to link resources located in Sharepoint (i. e. values for ImageUrl or IconUrl) be sure to enter the relative path to the location where the file resides and do not enter the full server path:


· wrong path:
https://auth.iveco.com/italy/PublishingImages/file.jpg

· right path:
/italy/PublishingImages/file.jpg
To create a new Iveco Dealer Locator Box widget, access the target page in edit mode and, in a WebPartZone, click the Add new Web Part button, then follow  Custom > Iveco Dealer Locator Box.
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Press the Add button to confirm.
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In edit mode of the widget you can set the configurations for it by means of the toolpart. 
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Here you can only select one of the available IvecoDealerLocator previously added in the WebPartsList list, the Default Brand and render the webpart in one or two columns.
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Press OK button to confirm your configurations.

9.6 Iveco Newsletter Box

This widget is used to create boxes that allow the users to subscribe to the newsletter service.
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Once the email field is filled, and the end-user click the link button for subscribe, he will be redirected to a page for the registration to the newsletter’s service.

If you want to create new Iveco Dealer Locator Box, you have first to add new “IvecoDealerLocator” items within the WebPartsList list, as shown below.
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You have to configure the following fields:

1. CategoryLabel: The text of the label shown in the top of the widget
2. IconUrl: the url of icon shown in the top of the widget
3. Title: the title of the widget
4. ImageUrl: the url of the image shown inside the widget
5. Alternative Text: the alternative text for the image
6. Abstract: the text shown in the middle of the widget

7. Email Label: the text shown in the textbox in which end-users insert their mail address

8. Button Label: the label of the button to start the search
9. Target: how to open the linked resource (same page, new page)

In order to link resources located in Sharepoint (i. e. values for IconUrl, ImageUrl) be sure to enter the relative path to the location where the file resides and do not enter the full server path:


· wrong path:
https://auth.iveco.com/italy/PublishingImages/file.jpg

· right path:
/italy/PublishingImages/file.jpg

To create a new Iveco Dealer Locator Box widget, access the target page in edit mode and, in a WebPartZone, click the Add new Web Part button, then follow  Custom > Iveco Newsletter Box.
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Press the Add button to confirm.
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In edit mode of the widget you can set the configurations for it by means of the toolpart. 
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Here you can only select one of the available IvecoNewsletter previously added in the WebPartsList list. 

Press OK button to confirm your configurations.
9.7 Iveco Promotions Box

This widget is intended to create boxes linked to the promotions pages.
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This widget can have the size of one, two or three columns. In other words it is possible to configure up to three promotions available inside the entire market.

In order to use this widget, you have to access the page in edit mode and in a WebPartZone click the Add new Web Part button, then follow Custom -> Iveco Promotions Box.
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Press the Add button to confirm.
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In edit mode of the widget you can specify the values for the following properties: 
· Category: the text displayed inside the black label

· Icon Url: the url of the icon shown in the top of the widget
· Promotion 1: the promotion page linked by the first box

· Promotion 2: the promotion page linked by the second box (optional)
· Promotion 3: the promotion page linked by the third box (optional)
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Press OK button to confirm your configurations.

In order to link resources located in Sharepoint (i.e. values for IconUrl) be sure to enter the relative path to the location where the file resides and do not enter the full server path:
· wrong path:
https://auth.iveco.com/italy/PublishingImages/file.jpg

· right path:
/italy/PublishingImages/file.jpg

9.8 Iveco Tag Cloud Box

This widget is used to create a box with the Iveco’s tag cloud.
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In order to use this widgets access the page in edit mode and in a WebPartZone click the Add new Web Part button, then follow Custom -> Iveco Tag Cloud Box.
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Press the Add button to confirm.
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Access the widget in edit mode to specify the values for the following properties by means of the toolpart:

· Category: the text displayed inside the black label

· Icon Url: the url of the icon shown in the top of the widget
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Press OK button to confirm your configurations.

In order to link resources located in SharePoint (i.e. values for IconUrl) be sure to enter the relative path to the location where the file resides and do not enter the full server path:


· wrong path:
https://auth.iveco.com/italy/PublishingImages/file.jpg

· right path:
/italy/PublishingImages/file.jpg

9.9 Iveco Mail Alert Box

This widget allows end-users to subscribe to the mail alert service.
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This widget hold just a column. Once the email field (mandatory) has been filled, the user has redirected to a page for  subscribe to the mail alerting service.

If you want to create new Iveco Mail Alert Box, you have first to add new “IvecoMailAlert” items within the WebPartsList list, as shown below.
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You need to specify the values for the following properties:

1. CategoryLabel: the text of the label shown in the top of the widget
2. IconUrl: the url of icon shown in the top of the widget
3. Title: the title of the widget
4. Abstract: the text shown in the middle of the widget

5. Releases: if checked, users that uses this box to subscribe to the service will receive every releases update
6. Kits: if checked, users that uses this box to subscribe to the service will receive every kits update
7. Email Label: the text shown in the textbox in which end-users insert their mail address
8. Button Label: the label of the button to subscribe
9. Target: how to open the linked resource (same page, new page)
In order to link resources located in SharePoint (i.e. values for IconUrl) be sure to enter the relative path to the location where the file resides and do not enter the full server path:


· wrong path:
https://auth.iveco.com/italy/PublishingImages/file.jpg

· right path:
/italy/PublishingImages/file.jpg

To create a new Iveco Dealer Locator Box widget, access the target page in edit mode and, in a WebPartZone, click the Add new Web Part button, then follow  Custom > Iveco Mail Alert Box.
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Press the Add button to confirm.
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In edit mode of the widget you can set the configurations for it by means of the toolpart.
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Here you can only select one of the available IvecoMailAlert previously added in the WebPartsList list. 

Press OK button to confirm your configurations.

9.10 Iveco News Box

This widget is used to display news box related to the current market. 
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It is possible add up to three news.

In order to use this widgets access the page in edit mode and in a WebPartZone click the Add new Web Part button, then follow Custom -> Iveco News Box.
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Press the Add button to confirm.
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Access the widget in edit mode to configure the following properties by means of the toolpart:
· Category: The text of the label shown in the top of the widget
· Icon Url: the url of the icon shown in the top of the widget
· Box News 1, 2, 3: you can add
· A specific news -> you have to insert the page url inside the “select from specific news” textbox
· The last news, the second to last, the third to last or the fourth to last one, selected from the combo
In order to link resources located in Sharepoint (i.e. values for IconUrl) be sure to enter the relative path to the location where the file resides and do not enter the full server path:


· wrong path:
https://auth.iveco.com/italy/PublishingImages/file.jpg

· right path:
/italy/PublishingImages/file.jpg
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If you choose to have one of the last news, when a most recent news will be published, the widget will automatically update the content.

9.11 Additional Meta Tags

You can also add others additional tags <meta> to the pages. To do that you have to navigate to the list ‘ScriptsList’ at market level and editing the item named ‘AdditionalMeta’.
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In order to edit the item you have to click on the arrow button of the item and select Edit Item. See the figure below.
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You have to assign the entire Html code for the tag to the field ‘script’. 
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The content of this field will be added to all the pages of the market where you are editing the ScriptsList. 

10 Page Tagging, Page Additional Code and Meta Tags

10.1 Page Tagging

Each page of the site can be edited in order to tagging it from a list of existing tags.

· To do that you need to enter into the Pages library of the section in which your page is located.

· Then click on the arrow button of your interested page and select Edit Properties.   
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At the bottom of the page you can find now the Tags settings.

Here you can insert all the tags that you need by selecting them from the left list and moving them to the right list. You can insert the tags one by one or together and you can also remove all those tags that you don’t need anymore.

Once this is completed press OK in order to confirm your settings for the page. 
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Then remember to check in and publish the page in order to have the modification available on the public site.
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Notes:

The page tags will be automatically indexed by the system basing on a scheduler that runs every day. Therefore, your tagging will not be visible on-line until the indexing runs again.    

10.2 Meta Description Tag

A tag of type <meta name=”description” content=”[…]”> is automatically added to pages. The value of the ‘content’ attribute of this tag is assigned with the first 155 characters of the main text of the page (property Text Center). See figure below.
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You can change this value setting the page property ‘Meta Description’. In order to set the ‘Meta Description’ property you have to navigate to the Pages library in which your page is located then click on the arrow button of the item related to your page and select Edit Properties. 
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Writing in the textbox labeled ‘Meta Description’ you assign the value of meta description content attribute. See the figure below.
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Then remember to check in and publish the page in order to have the modification available on the public site.
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10.3 Additional Code

Each page of the site can be edited in order to add to it additional code (e.g. client script code)

· To do that you need to enter into the Pages library of the section in which your page is located.

· Then click on the arrow button of your interested page and select Edit Properties.   
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In order to add the additional code to the page you have to add that code in the ‘Additional Code’ field and then save the updates. See the picture below.
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Then remember to check in and publish the page in order to have the modification available on the public site.
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10.4 Additional Meta Tags

You can also add others additional tags <meta> to the pages. To do that you have to navigate to the list ‘ScriptsList’ at market level and editing the item named ‘AdditionalMeta’.
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In order to edit the item you have to click on the arrow button of the item and select Edit Item. See the figure below.
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You have to assign the entire Html code for the tag to the field ‘script’. The content of this field will be added to all the pages of the market where you are editing the ‘ScriptsList’. 

11 Collections

Collections are content aggregators that can be created and associated to pages of the site.

There are different kinds of Collections:

· Catalogues

· Photo

· Technical Sheets

· Video

· Pdf Collection (for Corporate site only)

For each market site there is a specific site dedicated to Collections management and there is a specific site for each kind of collections under that site.

In order to manage Collection go to its specific site from Wheel Button [image: image204.jpg]


 -> Site Content, then use the Top Link Collections menu to select the particular collection site you are interested.
Files related to a specific category can be uploaded in the appropriate SharePoint Document Libraries and then associated to a specific Collection. Collections can be linked to pages from the navigation settings. In the following paragraphs we are going to describe how to manage the different kind of collections (for information about Photo Collection management see chapter 15.4 Photo Gallery).

11.1  Catalogues Collection Management

We are going to describe how to create a collection of type Catalogs with an example step by step. If your goal is to create a collection of pdf document in a company website (i.e. www.iveco.com/it-it) does not refer to this section but please follow the instructions in section 11.3 (Pdf Collection).

The first step is to upload the interested files into the library Documents in the Catalogues site under Collections.

Here you can upload your catalogues and organize them by folders.
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In order to upload files use the Upload Document button in the Ribbon.
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Next step is to create one or more instance of Collections and links to them the catalogues you just uploaded. For example, you can create a collection called Stralis and associate all catalogues related to the Stralis to it. In order to do that, select the Catalogues Collections list and create a new item in to it.
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Type the name of the collection into the Title field and then press OK

You need now assign your catalog files to the Collection just created, in order to do that you have access  the list 'Catalogue Items' and create all the items for that Collection.
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You need to edit at least the following fields:

· Title: it is the name to display for the current item
· File Path: press Browse in order to select the catalogue file to associate to the current item 

· Icon Path file (optional): the system loads by default the pdf icon.

· Item Order: this is the position of the current item in the collection comparing to the others present in the list

· Visible: by deselecting this flag you are able to hide the current item

· Collection: this dropdown shows the list of all the existing collections previously created. You can select the collection of your interest.
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And you can set the property Issue Pdf Link with the full URL to an element hosted in the www.issue.com site in order to open the document in the browser and browse it.

Repeat the previous steps in order to associate new catalog files to your Collection.

For values of File Path and Icon File Path be sure to enter the relative path to the location where the file resides and do not enter the full server path:


· wrong path:

· https://auth.iveco.com /italy/collections/catalogues/Documents/Documenti Azienda/Mobility_ITA 2011.pdf

· right path:


· /italy/collections/catalogues/Documents/Documenti Azienda/Mobility_ITA 2011.pdf

Your collection items have been created properly in list and now you can link your collection to one or more pages of the site using the settings of the Navigation menu. For further information refer to Tools Management in Navigation, Chapter 12.2.

If you need to know how many items are associated to a specific collection you can filter the collection column of the list. All items related to that collection will be filtered and displayed in list.

11.2 Technical Sheets Collection Management

The technical sheets are managed by Technical Sheets Collection list.

To access this collection go to the market site and then select Collections as shown below. 
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On the left side you will see two kinds of collection the Technical Sheets Items and the Technical Sheets Collections.

It is necessary because each technical sheet item needs to belong to a technical sheet collection. 

You can Add a Collection using the Ribbon: Items >> New Item >> Technical Sheets Collections as you can see below
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In the form that creates a new list item you have to specify the title of the collection and a field that will appear in the dropdown list of the page.
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The technical sheets items allow you to add an Item referred to a particular technical sheets collection. For doing this you have to access to Technical Sheets Items then List Tools >> Items >> New Item >> Technical Sheets Items
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In the next form that will appear, you have to specify the path of the .pdf file and the Collection of belonging.

Be sure to enter the relative path to the location where the file resides and do not enter the full server path:


· wrong path:

· https://auth.iveco.com /italy/collections/technical_sheets/Documents/massif/cabinato/25S18 CAB.pdf

· right path:


· /italy/collections/technical_sheets/Documents/massif/cabinato/25S18 CAB.pdf

[image: image216.png]Title *

Description

File Path

Icon File Path

Item Order
Visible

Collection

Click for help about adding basic HTML formatting.

Brouse..

(None)

Cancel





For further information refer to the Pressroom contact us paragraph.
11.3  Pdf Collection
This kind of Collection is for Corporate site only if you want to link a catalogue of pdf in Corporate site you have to use this Collection and do not use Catalogues.

In order to create a new Pdf Collection, from the Corporate Site access the Pdf Collection site using Wheel Button [image: image217.jpg]


 -> Site contents and from the result page use the Top menu link Collections to access to Pdf Collections sub site. Access into Pdf Collections and create the item for your Collection.
Then access the Pdf Collections Items list in order to link files to your Collection. 
For each file that you want to assign to the Collection, create a new item specifying followings attribute values:

Title: the title that will be appear in the tools of the page to open the file. For example you can upload different language versions of a document and assigning to each of this item the name of the language. Then when the user will choose “Italiano” the italian version of the document will be opened.
File Path: the location where the file is saved. Be sure to specify the relative path to the file and do not use the full server path:
wrong path: https://auth.iveco.com /it-it/sala-stampa/cartella/documents/modelli_attuali/new%20stralis%20hi-way/20120701_newstralis_ita%20last.pdf
right path: /it-it/sala-stampa/cartella/documents/modelli_attuali/new%20stralis%20hi-way/20120701_newstralis_ita%20last.pdf
Position: the position in which the name of the file will be shown in the drop down in the page where you will link the Collection by means of Tools.
Collection: the pdf collection to which link the file
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12 Navigation Menu

The Navigation menu is a particular page that allows users to configure the menu levels of the site and enable/disable a list of features to assign to the pages.   

It has a visual interface characterized by a tree view and allows users to work through several attributes for the navigation management of the pages and a list of functionalities linked to some specific sections of the site. 
The Iveco Navigation is reachable by selecting Manage Iveco Navigation from Wheel Button [image: image219.jpg]


 -> Manage Iveco Navigation
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A tree view display all menu items starting from the first level.

Each single item can be edited, added or deleted just by using the appropriate options.

[image: image221.png]&

@ &1 Prodotti

& &\ Usato [break]

@ &1 Post Vendita

@ & Senvizi

& &\ Rete [break]

& Sala Stampa [break]

@ & Azienda

@ &\ Camion & Servizi [break]

‘Ada Child Node...

Delete Node





The navigation manages the following zone of the page:

· Main navigation of the page

· left side navigation

· Tools inside page
It follows a description about the management of each part of the navigation.
12.1  Main Navigation Menu and left menu
Navigation side:
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Page side:
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When you add a new node to the menu, you are able to configure some attributes. Not all attributes are available for each node; it depends if you are creating a child node under a not break level node or not, and it depends on the level of the node.
Example of add child node under a not break node:
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Example of add child node under a break node:
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In the following chart you can find the meaning of the main attributes of the navigation settings. 
	ATTRIBUTES
	DESCRIPTION

	Title (mandatory)
	it is the name of the item to display on the menu

	TitleSEO
	Once edited, this title will be automatically placed by the system into the html of the page. It needs for Search Engine Optimization.

	BannerAltSEO
	

	Position (mandatory)
	The order of the current item on menu

	BreakLevel
	This attribute is related to the typology of menu to associate to the current node.
If the BreakLevel attribute is set to NO the item will be associated to the Main Navigation. 
If the BreakLevel attribute is set to YES for a specific node, all its “child” nodes will be associated to the Left Navigation as shown below.
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In the following example the “Break” option is set to “YES” from the 4th level node but it is up to the editor deciding in which node the break need to be applied 
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In fact, the break can be used on any node level. In the following example the Break has been selected starting from the first menu level
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	Thumbnail
	It is only available for the 4th node level (as shown below) and it allows users to associate a thumbnail to a specific item (e.g. Leggeri) of the menu

[image: image231.png]



[image: image232.png]&

& &4 Prodotti

8 5. 0n Road
< 2 frmia

2 Daily Furgone [break]
2. Daily Cabinato [break]
5. Dally HI-MATIC [break]
B Medi (6.5-18.01)
& Pesanti (>=161)
. 0ff Road
Halveco Bus
& Camper
& Tecnologie
& Usato [break]
. Post Vendita
s senvizi
. Rete [break]






	Image Url
	Through this field you can edit the path of the image to associate to the current node.

Do not type any absolute url but edit the path starting from the market string 

WRONG: https://auth.iveco.com/italy/documents/........swf
CORRECT: /Italy/documents/…….swf


	Inherit flash from parent
	If this attribute is selected, the page of this node will inherit the image of the parent


	Inherits tools
	If this attribute is set to YES this page will pick the tools from the father node, otherwise it is necessary to edit the tools as shown in the figure below:
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See the next paragraphs to have more details about the tools configuration.



	Page Url
	Type here the path of the page to associate to the current node.

Do not type any absolute url but edit the path starting from the market string. 

WRONG: https://authweb.iveco.com/Italy/pages/test.aspx

CORRECT: /Italy/pages/test.aspx


	Open Page in
	This attribute specify if the target of the page.

	More Information
	If this attribute is selected, the More Information button will be automatically activate on the page associated to the current node and the contact form will be visible.
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See the next paragraphs to have more details about this.




12.2  Tools management

If you want to configure the tools of a page it is necessary that the Tools >> Inheritance is active propoerty is set to NO
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By pressing the edit button you can configure the tools.
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In the following chart you can find the meaning of the main attributes of the tool settings. 

	ATTRIBUTES
	DESCRIPTION

	Tool Type
	In this attribute you can choose if you want to use a catalogue or a single link.


	Position 
	The order of the current item on menu



	Catalogue (only if the tool type is Catalogue)
	Here you can specify the catalogue related to this tool. For more details about the management of catalogues see the Collections chapter.


	Image
	Through this field you can edit the path of the image to associate to the current node.

Do not type any absolute url but edit the path starting from the market string 

WRONG: https://auth.cert.iveco.com/italy/documents/........swf

CORRECT: /Italy/documents/…….swf


	Title (only if the tool type is Single Link)
	This attribute is related to the name of the single tool.



12.3  More Info Management
To manage the more info box you have to go to the node where you want it and you have to flag the More Information attribute.

Once this attribute is flagged in, the user will be able to insert three additional settings as follows:
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The first 3 fields are related to the promotion source:

· Promotion source (e.g. web.iveco.com/italy)

· Initiative report source (e.g. the text description of the initiative: Iveco risponde)
· Initiative report detail (e.g. the name of the initiative: Daily Furgone - Gamma)
The TO and CC fields can be edited with the interested email addresses. If they are not edited the lead compiled by the internet users will be sent to a preconfigured email address already set-up on the market site.

The Send more field can be used in order to choose a specific format that will be sent for the lead. You can choose between the csv and xls format.  
12.4  How to create a node 

In order to create a new node in the navigation you just need to select the item in which the new node will be created.
In the example below it is showed how to create a new node item within the “Azienda” node.   
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Once the new node is created it will be displayed totally blank. To edit all the attributes of a node please refer to the chart description described in the previous paragraph. 

12.5  How to edit a node

In order to edit a node of the navigation you just need to select the item to modify and then press Edit.   
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You will be able then to modify the attributes of the current node.
Press OK in order to confirm the modification or press Cancel in order to avoid any changes to the node. 
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For the Image Url field be sure to enter the relative path to the location where the file resides and do not enter the full path of the server:


· wrong path:

· https://auth.iveco.com/italy/sitecollectionimages/iveco/swf/placeholder_prodotti.swf
· right path:

· /italy/sitecollectionimages/iveco/swf/placeholder_prodotti.swf
12.6  How to delete a node
In order to delete a node from the navigation you just need to select the interested item and then press Delete Node.
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Press OK to confirm or Cancel. 
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12.7  Navigation Press Area
The Press Area Navigation have to be configured using its dedicated section in Navigation Management. Site Action -> Manage Iveco Navigation -> Press Area Section -> Main Navigation.
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The Press Area Navigation is configurable in the same way of the navigation of the other areas as shown in the previous sections of this chapter.
In order to add a page to the Press Area Navigation expand the tree to the node of break you want to add the page below and add a new node there (refer to section 12.4 – How to create a node).

The node can be configured in the same way of nodes in other areas of the Iveco site. For example in order to link Catalogue follow the instruction shown in section 12.2 (Tools Management) and 11.1 (Catalogues Collection Management). Note that for Corporate Site (i.e. http://www.iveco.com/it-it) you can’t use Catalogues Collection but you have to use Pdf Collection (refer to section 12.3 – Pdf Collection).
12.7.1 How to move a node

In order to move a node from the navigation just need to select the interested item, then press In the Navigation Area Press the dropdownlist “Move selected node to” and then select the destination node.
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Press OK to confirm or Cancel.
12.8  Photo Gallery

12.8.1 Photo Gallery Navigation Management

The Photo Gallery section is characterized by 3 navigation levels. All levels are defined through the Navigation Management. The 3rd one level is intended to own break level nodes (nodes that point to pages).  The break function can be used on each node. Unlike the old Iveco site, the 3rd level nodes are displayed in a layer under the first two. 
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Now we are going to explain how to configure each Photo Gallery site nodes by Navigation management for Press Area section: from Wheel Button [image: image249.jpg]


 -> Manage Iveco Navigation -> Press Area -> Main Navigation.
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This is the whole tree structure of the photo gallery section already defined in the navigation
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12.8.2 Photo Gallery Parent node (1st level)
The Photo gallery parent node is configured with the following attributes:

· Title: it is the title displayed on the top menu

· Node Type: it is the typology of the node that cannot be edited due to the fact that it is automatically recognized by the system.

· Position: it is the order position on the top menu. 

· Break: this is the attribute related to the type of navigation node associated to the child nodes. The break option is set as “No” because its child nodes are part of the top menu.

· TitleSEO: it is the SEO title 
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12.8.3 Photo Gallery – 2nd level node

The 2nd level node (currently defined as Current Models) is a child node of the Photo Gallery one.

It is a node configured with the following properties:

· Title: it is the title displayed on the top menu

· Node Type: it is the type of the node that cannot be edited. It is automatically recognized by the system

· Position: it is the order position on the top menu. In this case it is set as 1.

· Break this is the attribute related to the type of navigation node associated to the child nodes. The break option is set as “No” because its child nodes are part of the top menu.

· TitleSEO: it is the SEO title
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Below is shown how the node is rendered within the top menu according to configured properties.

Of course, you can configure additional nodes for this menu level just by selecting the parent node (Photo Gallery) in Area Press Navigation and clicking on the “Add Child Node” button. The new nodes will be rendered as brothers of the Historical Archive node at the same menu level.
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12.8.4 Photo Gallery – 3rd level node

The 3rd level node (e.g. Massif) is a child node of the Historical Archive one.

It is a node configured with the following properties:

· Title: the title displayed on the top menu

· Node Type: it is the typology of the node that cannot be edited. It is automatically recognized by the system

· Photo Collection: filling this field you are able to specify a photo collection to associate to the current node. The selected photo collection will be automatically displayed in the landing page of this node.

· Position: it is the order position of the current node in the left menu..

· Break: at this level you cannot edit this attribute 

· TitleSEO: it is the SEO title associated to the current node

· Thumbnail: specify the url of the thumbnail that will appear in the top menu: be sure to specify the relative path and do not use the entire server relative path:

· wrong path: https://auth.iveco.com/italy/sala-stampa/PublishingImages/archivio%20storico/Massif.jpg

· right path: /italy/sala-stampa/PublishingImages/archivio%20storico/Massif.jpg
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12.8.5 Photo Gallery Collections Management

In order to manage Photo Gallery Collections go to Photo section under Collections top Menù of Site Content area.
Here you will find two list (Photo Collections and Photo Items) and a Picture Library. This are the data structures that you will use in order to manage the Photo Collections.
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In order to upload new photos that can be used in a Photo Collection access the PictureLibrary and upload you photos. Unlike as it was in the old Iveco site you have to upload just the image in high resolution. 

In order to create a new Photo Collection access the list Photo Collections and create a new item using 

the Ribbon (Items tab -> New Item -> Photo Collections). It is important to specify the title of the new photo collection.
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To add a new photo to a Photo Collection access the list Photo Items and create a new item using the Ribbon Items -> New Item -> Photo Items.
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Now select the file in high resolution that you have first stored into the Picture Library and the title of the Collection you want your photo will belong to (use the drop down list). Use only the link high resolution, others are intended only for backward compatibility with the previous system.
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Now you can associate your Photo Collections to a node in the Area Press Navigation. To do that access the Area Press Navigation Management: [image: image260.jpg]


 -> Manage Iveco Navigation -> Press Area Section -> Main Navigation.

Then expand the tree and select the 3rd level node to which you want to associate the Photo Collection. Or create a new one node. Editing the properties of the node (press Edit button) you can associate the desired Photo Collection by means of the drop down list for the field Photo Collection.

The followings pictures show the association of the Photo Collection “Massif” to the node “Massif”. How you can see the Photo Collection list own an item with title “Massif” and the Photo Items list own a list of pictures that are associated to the “Massif” Photo Collection by means of the Collection field.
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Photo Collections:
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Photo Items:
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13 Footer 

Each page on the site has footer, divided into two main zones:

· Social Networks section;
· Main footer zone.
13.1 Social Networks section
In the first area will be hosted the contents from the official Iveco Profile on the main Social Network:

1. Facebook

2. Twitter

3. YouTube
4. Flickr
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Any Box stores contents for each profile, but you can display or remove the boxes according your needs. It is also possible to get more than a single content from the same social network.
To manage the footer you need to access the FooterManagerSocialNetwork page, for doing this go Manage Iveco Navigation: [image: image265.jpg]


 -> Manage Iveco Navigation.
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After that you have to access to Social Elements under Footer Section
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In this page there are two areas: the first one refers to the Social Updates link that you can see when the footer is closed, the second one is intended to manage each single box of the footer when it is opened.
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1) Footer Closed:
Desktop:
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Mobile:
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2) Footer Opened:
Desktop:
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Mobile:
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The social Updates zone is quite intuitive you have just to specify the address for the single social network channel and the target of the page. You can confirm pressing the green checkmark.
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The Second zone manages each single box of the footer opened. 
You can add a new content by clicking the green add symbol, a Content Zone will appear where you can specify the social network that you want in that box, and the type of content (Last Content or Specify content). Then you can press the Apply button.

Pay attention: the only available type of content for Facebook and Twitter is “Last Content”.

[image: image275.png]‘Social Update Boxs section

Last Content

R

Last Content

R

Last Content

R





You can delete a content from the footer by clicking the red symbol at the top right.
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You can also edit a content by clicking the notepad symbol at the top right. A Content Zone will appear to make you perform your changes.
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13.2 Main Footer section
The Footer.aspx page allow to configure the web site areas highlighted in the below screenshot.
Desktop view:
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Mobile view:
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The configuration can be done through the user interface accessible from from Wheel Button [image: image280.jpg]


 -> Manage Iveco Naigation -> Footers Elements.

In the following paragraphs you can find all useful instructions in order to manage the two pages.
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The footer is divided in several zones; each of them is configurable by clicking the menu items present on the left section of the navigation page (highlighted in red on the above image).

Desktop view:
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Mobile view:
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In the following paragraphs are detailed all steps in order to manage the configuration of each single zone.

Brand Logos [image: image284.png]eco R




This section allows to configure the zone which contains the logos associated to the different brands to display on the footer.
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The configuration can be done through a tree user interface (with a unique level in which the leaf nodes are the single brands displayed on page) as shown below.

By selecting the parent node (“Brand Logo”) and clicking on the “Add” button it is possible to add a new brand element.
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The editable properties for each single brand are the following:

· Title: it is the value displayed in the tooltip associated to the element (this value is also used as SEO information)

· Target url:  url of destination

· Position: position of the item in the sequence of the displayed brand logos

· Target: it allows specifying “how” the content will be displayed.

· This: the content will be displayed in the self (current) page

· New: the content will be displayed in a new page

· Popup: the content will be displayed as a popup (in this case you are allowed to specify its dimensions). It is suggested not to set any url with a domain which is different to the one of the hosted page because for security reasons the browser could block the opening of the popup.

· Image: logo of the brand. Be sure to insert the relative path to the location where the file  resides and do not enter the full path of the server:

· wrong path:

· https://auth.iveco.com/italy/SiteCollectionImages/Iveco/img/shared/logo_irisbus_footer.gif

· right path

· /italy/SiteCollectionImages/Iveco/img/shared/logo_irisbus_footer.gif

· Alt: text to display if it won’t be possible to associate any image to the current item.

By clicking the “Add” button the new node is created, with the specified order, within the tree. By clicking the “Cancel” button the adding action is cancelled.

By selecting a leaf node in the tree all its attributes will be displayed. If the “Delete” button is selected, the current node will be deleted after the confirmation request of the warning message; the “Edit” button allows modifying the properties previously configured.
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This section allows configuring the footer zone which contains the tools.

The configuration can be done through the tree user interface (with a unique level in which each leaf node is a single tool) as shown below.
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By selecting the parent node (“Tools”) and clicking on the “Add” button you can add a new tool.
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The editable properties for each single tool are the following:

· Type: tool type
· Link: the tool is a link to a page
· News: it is a particular tool which allows displaying the popup of the latest news
· Position: position of the tool within the toolbar
· Title: the value of this property is displayed as a tooltip of the element (this value is also used as a SEO information)

· Text: text associated to the tool
· Target Url: URL of destination
· Target: it allows specifying “how” the content will be displayed.

· This: the content will be displayed in the same window

· New: the content will be displayed as a new window

· Popup: the content will be displayed as a popup (in this case you are allowed to specify its dimensions). It is suggested not to set any URL with a domain which is different to the one of the hosted page because for security reasons the browser could block the opening of the popup.

· Image: URL of the image displayed after the text. Be sure to insert the relative path to the location where the file  resides and do not enter the full path of the server:

· wrong path:

· https://auth.iveco.com/italy/SiteCollectionImages/Iveco/img/shared/ico_sitemap.gif

· right path


· /italy/SiteCollectionImages/Iveco/img/shared/ico_sitemap.gif

· Alt: text displayed in case it won’t be possible associating an image to the item
The News type tool compared to the Link one previously described, is configurable with a reduced list of properties as you can see on the following screenshot.
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By clicking on the “Add” button the new node will be created within the tree in the specified position. By clicking the “Cancel” button the adding action will be cancelled.

By selecting a leaf node in the tree its own properties will be displayed. If you press “Delete” the selected node will be deleted (after the confirmation to the warning message); if you press “Edit” you can edit the properties of the selected node.
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This section allows configuring the Copyright zone of the footer. The user interface for the properties configuration is the following.

The “Enable” checkbox allows enable/disable the Copyright zone of the footer.

The Text property is the text displayed within the Copyright zone of the footer.

If you press the “Save” button the edited information will be saved.
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This section allows configuring the Company zone of the footer. The user interface for the properties configuration is the following.

The configurable properties are the same already described on the Career e sitemap tool zones.

14 Press Room

This chapter lists all available features of the Press Room describing the steps to follow for the content management

14.1  Home Page Press Area
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This layout refers to the Home Page of the Press Area. 

In the header section are displayed the top image and the html abstract of the last press release.

In editing mode editors can change the browser title and configure up to four widgets. For further details on how to configure a widget, please refer to the “web widgets” chapter.
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14.2  Home Page Press Release

This is the home page of the Press Releases Area.
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In the header section are displayed the top image and the html abstract of the last press release.

This page automatically display the content depending on the creation of the news pages. For further details about how to create news, please refer to the “Press Releases” chapter.

14.3  Press Kits 
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This layout is intended to be used in the Area Press section under the Press Kits sub-site.

In order to create a new Press Kit Page you have to access the /Pages library in the Area Press/Press Kit site using Site Action -> View All Site Contents -> Pages.

Use the Ribbon to create a new page:  Library Tools tab -> Documents > New Document. Enter values for Title, select the Iveco Press Page - Kit layout, and press CREATE.

In editing mode, you can manage all the content of the Press Kit Page except for the tools that have to be managed from Navigation as described in Chapter 12.2. 
You can enter the values for the content that will match to the information shown in the above screenshot:

1) Browser Title

2) Page Title
3) The top image displayed in the page header
4) The Title related to the canvas image

5) The Description related to the canvas image

6) The position of the Title and the Description related to the canvas image
7) The Main Content
8) The Main Content Mobile

9) The Read More Content (Page Additional Content)
10) The Read More Content Mobile (Page Additional Mobile Content)
11) Widgets section
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For the image be sure to enter the relative path to the location where the file resides and do not enter the full path of the server:


· wrong path:
https://auth.iveco.com/italy/PublishingImages/file.jpg
· right path:
/italy/PublishingImages/file.jpg

To link the Press Kit Page in Area Press Navigation refer to chapter 12.7.
In order to insert and manage tools content as shown below, please refer to the Chapter 12.2
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14.4  Press Releases

This layout is used in the Press Release section.
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To create a new page you have to enter the Press Release area and then using the View All Site Content go to Pages.

Then, use the Ribbon and from the Files tab, select New Documents > Iveco Press Page.
Now enter the Title, select the Iveco Press Page, and click on CREATE.

In editing mode, you can enter the following content using the available editing fields and controls:

1. Slider section to set the homepage slider:
1) Hide in press home page, welcome and canvas. Check the checkbox in order to do not show the release in the Press Release Home Page, Press Room Home Page and Welcome Page.
2) Press Home Page Image. The image that will be shown in the Press Release Home Page and Press Room Home Page.
2. The main section to set:

3) Send in next Mail Alert. Check this checkbox in order to send this release in the next scheduled Mail Alert to people who have registered to the service.
4) The Browser title
5) The Press Releases Title
6) The Press Home Page Abstract. The abstract that will be shown in the Press Release Home Page for the press release
7) The Press Release Category
8) The Press Image
9) The Title related to the canvas image

10) The Description related to the canvas image
11) The Position related to text in the canvas image
12) The News Date
13) The Press pdf download link
14) The Linked photo gallery. You can select a photo gallery to link to this release directly selecting one by means of the drop down list.
15) The Html text of press release
Edit View of Iveco Press Release.
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Display View of Header of Iveco Press Release Home.
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Display view of the release
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For the images be sure to enter the relative path to the location where the file resides and do not enter the full path of the server:


· wrong path:
https://auth.iveco.com/italy/PublishingImages/file.jpg
· right path:
/italy/PublishingImages/file.jpg

15 Contact us

15.1  Contact us Hub Page

This is the main page that you can use to access to the contact us area. This page is structured to have a certain number of reasons to contact Iveco. There are, in fact, some functional boxes that represent a link to a FAQ page, or to external page. The structure of the different FAQ is managed in a particular list (for more information you can refer to the next paragraph).
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Each reason of contact is composed of:

· Image;

· Title;

· Subtitle;

· Description;

· Link to a FAQ page or to an external site.

15.1.1 Contact Us HomePage List Management

The filling of the selection of the different contact us types is managed by the ContactUsHomePage list.

To access this list go to the Contact Us sub site and use the View All Site Content view from the Site Actions menu. 
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Each folder inside the list represents a collection of different FAQs type. Inside that can be configured a variable number of items. If you want to create your own set of FAQ select the List Tools tabs from the Ribbon and then Items >> New Contact Us Question.
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In the creation of this folder the main fields to fill in are the Name that identify the folder, the position of the folder and the text of the Question as shown below.
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Now using the Ribbon you can add a new Iveco Box Item: List Tools >> Items >> New Item >> IvecoBox.

[image: image309.png]BROWSE | meMS | UsT

New | New  Vew Edt
Keme Foder fem fem

=

Create anewlist tem.

(e Contac s uestion

(Create a new New Contact Us Question

Version Hitory a
Stared itn o
Ataen | met Tegs& | Workfows Ap
Detetetem e ew Noies
Actions _Share & Track_Tags and Notes Work
ew item or edit this list
ems  fds - Find an item el
O contact Us Question Position




Each item can be configured using the following fields:
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The page URL is the address of the FAQ page to whom this particular question refers to. For further information about the FAQ page, please refer to the following paragraph.

For the values of Image URL and page URL fields be sure to insert the relative path to the location where the file resides and do not enter the full path of the server:


· wrong path:

· https://auth.iveco.com /italy/Prodotti/PublishingImages/Widgets Contact us/veicolonuovo.jpg 
· right path:


· /italy/Prodotti/PublishingImages/Widgets Contact us/veicolonuovo.jpg
It is also possible to add a title and a description to the Contact Us Home Page. In order to do that you need to add values to dedicated items in the list Labels in the root market site. Supposing you are working on Italy Contact Us site, access Italy site in authoring mode and go to Labels list (Site Action -> View All Site Content -> Labels).

From here, you can set the Contact Us Home Page title and description by inserting values for the items ContactUsHomePageTitle and ContactUsHomePageDescription.
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15.2  Contact us FAQ Page

This layout is used for the Contact Us FAQ Page.

Steps to create and publish a new contactUsFAQ page will be depicted in the following.

· Access to the “Contact Us” section of the reference market (i.e. “Italy”) and create a new “Page”. (Files tab -> New Document -> Iveco Contacts);
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· Fill in the title of the new page and choose the page type “(Iveco Contacts) FAQ Page.
[image: image315.png]Create Page

Page Title and Description
Enter 3 URL name,tte, and descripton for ths page.

Page Layout

Select page ayout o control how the page il be displayed.

Title:

Description:

URL Name:

(iveco Contacts) Contact Us Form AT
(iveco Contacts) Contact Us Form A2
(Iveco Contacts) Contact Us Form B1
(iveco Contacts) Contact Us Form B2
(iveco Contacts) Contact Us Form B3
(Iveco Contacts) Contact Us Form B4
(Iveco Contacts) Contact Us Form B5.
(Iveco Contacts) Contact Us Form C1

e —

Checkspeling | | Creste





Going in edit some features will be available:

· Browser Title as simple single line text;

· A drop down list to select the folder of FAQs (to see how to configure the list related see the next paragraphs).

1) Page Title as simple single line text;

2) Page SubTitle as simple single line text; 

3) Page Description as simple multiple line text;

4) A webpartzone

Display View:
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Edit of Promotions Internal
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The bottom zone (in grey) needs to the user if cannot find the information that need, and can contact Iveco by clicking the black narrow.

Moreover you can configure the text in the grey footer ( 5 ) and the form that the will open when the black arrow is clicked.
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In edit some features will be available:

5) The text on left part as simple single line text;

6) The linkable text on the right as simple single line text;

7) The form related to the link configurable by a list (to see how to configure the list related see the next paragraphs). 
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15.2.1 FAQ List Management

The filling of the selection of FAQ folder is managed by the ContactUsFAQ list.

To access the list go to the sub site of Contact Us and use the View All Site Content, scroll down and find the list. 
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Each folder inside the list represents a collection of FAQs. Inside that can be configured a variable number of FAQ items. If you want to create your own collection use the new folder button.
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Now you can add a FAQ Item then go to Itsms tab >> Items >> New Item >> FAQ Item
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Adding a FAQ Item you have to specify the Title, the position of the item in the collection and the Description of the FAQ.
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Display View of FAQ related to the selection in edit phase.
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15.3 Contact us Technical sheets 

There is a layout that can be used as an editorial template for the technical sheets of the available Iveco vehicle. In this Page there is a dropdown list where it is possible to select a particular vehicle. 

The vehicles displayed in the dropdown list are configured in a proper column of the techinical sheets’ collection ( for further information see the next paragraph).
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Display view after selecting a vehicle.
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This layout in edit has the same fields of the previous one as you can see below, it also the grey footer to contact Iveco.
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15.4  Press Contacts 

The Press Contacts is a simple editorial page where are stored the main informations about the press office, the local and international office people.

On the left side there is an editable zone where you can specify the main contact information, such as the company, the address and the e-mail contact. There are two kinds of press contacts page, the first one regards the corporate site (like it-it or en-us) while the second one regards the site that are not corporate.

15.4.1 Press Contacts – Market Site
Below it is described the layout of the Press Contacts of not corporate site.

Display view:
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Editing View:
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On the right side, there are the informations about the international contacts.

To manage these contacts you need to access the IvecoPressContact list.

To access the list go to the sub site of your market and use the View All Site Content view. 
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In this list you can add an Iveco Market Contact item where you need to specify the information that will be shown in the contact page. In the case of not corporate market (like Italy, Germany…) you need to specify International for the ContactType attribute as shown below.
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15.4.2 Press Contacts - Corporate Site

The press contacts page of the corporate site has the same top left part but the other zones are quite different.

The right zone will display the international contact of the market chosen by the drop down list.
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In the bottom left part there are the local contacts (ContactType set to Local) of the current site.

16 Landing
T.B.D.
17 Special Site
T.B.D.
18 Iveco Popup and Form Manager

The Iveco Popup and Forms Manager allow the owners to:

1. enable/disable the send button in all market site contact us form;

2. create and customize the popup’s message;

For doing this you have to access to Iveco Popup and Forms Manager and click on update when you finished.
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19 Switch Language

19.1 Switch Language Market Site
In the market site available in multiple languages (i.e. Iveco Switzerland-it, Iveco Switzerland-de, Iveco Switzerland-fr) in the top of all pages to left side of the search area there is a combo box to manage the site language.
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The combo box is configured by a list named Countries, available at the root level of every market. For each language add/modify an item in the list with the following properties.

· Title: it is the value displayed in the combo box associated to the element;

· Position: position of the item in the sequence of the combo box;

· HomeUrl:  url of destination for the current site;

· PressUrl: url of destination for the press room in the current site (the combo box, in the press room site, display this url)
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If the Countries list in not present in the root level of the market site the combo box will be hidden.[image: image340.emf] 
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